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Introduction
The Fury-800 is a software synthesizer plug-in for Microsoft Windows (VST) and Apple 
macOS (VST/AU) simulating the KORG® Poly-800 Polyphonic Synthesizer from 1983. 
It is written in native C++ code for high performance and low CPU consumption. The 
main features are:

● Two band-limited DCOs with individual envelope generators (DEG)
● Two waveforms with additive harmonics (16', 8', 4', 2’) per DCO
● Single (paraphonic) lowpass VCF and Noise
● On-board sequencer and Chord Memory
● Pseudo-stereo Chorus effect
● Tweaks:

○ Up to 64 voices polyphony with Velocity
○ “God Mode” for real polyphony
○ Continuous parameter values and direct access

● Double precision audio processing
● Resizable user interface
● All parameters can be controlled by MIDI controllers
● Plug-in supports Windows (32 bit and 64 bit) and macOS (64 bit)

The Fury-800 is based on the new iPlug2 framework maintained by Oli Larkin and 
the iPlug2 team. Big thanks, guys!!! Without your work it would not have been 
possible to create a resizable Fury-800 user interface.

To resize the plug-in you just grab the yellow triangle at the bottom right of the Fury-
800 window and drag it. You can save the current window size using the menu entry  
“Save Window Size” in the Options Menu.

From The Poly-800...

Once upon a time I promised myself not to create a simulation of an existing piece of 
hardware that I do not own by myself. Anyway, after receiving so many mails about 
“Why not recreating the Poly-800?” I thought “Why not?”. After all, this could have 
been the first polyphonic synthesizer I’d ever had bought – if it were not for the 
mighty Bit One *cough, cough*...

In the mid 80’s, it was time for weird and futuristic designs. It was also time for 
transition (from analog to digital…) and for relentless cost reduction – how else could 
one explain the advent of music machines with zillions of parameters but only two 
buttons to edit them? The Yamaha DX7 became an icon of its time (plus beyond), and 
other manufacturers gave their new machines a similar look: Parameter numbers and 
ranges were printed on the face plate, knobs/sliders disappeared, pseudo-technical 
diagrams and LED displays were ubiquitous. 

Enter, stage right: The KORG Poly-800 from 1983. It had the look! It was polyphonic! 
It was programmable! It was cheap (and inexpensive)! It was sexy! Put on a strap 
and you could pose like a guitar player! It had only one filter for all voices? Ouch…

But it also had some outstanding features that are worth mentioning: Two DCOs, each 
with their own ADBSSR envelope generators (EG) and a funky way of additive 
waveform generation, a VCF with its own ADBSSR EG, a Chord Memory and on-board 
sequencer.
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… To The Fury-800

Well, I added some enhancements to my Fury-800 simulation:

• The Fury-800 can be 64 voice polyphonic – the Poly-800 only offered 8 voices 
(just 4 in DOUBLE mode).

• Velocity is ‒ optionally ‒ available.

• Due to technical reasons the Poly-800 was paraphonic with respect to the VCF 
(the special chip used for the eight DCOs did not output the individual DCO 
signals but a mixture of their octave signals; thus the signal of the DCOs could 
only be filtered in their sum). But the God Mode will turn the Fury-800 into a 
“true” polyphonic synthesizer.

• Where ever useful I turned step-like parameters into their continuous 
equivalents. For example you can adjust the level of the 8’ DCO wave instead of 
just turning it on or off.

• The sequencer in the Poly-800 offered 256 “steps” – but the correct description 
would have been that it offered 256 events (for example a chord of three notes 
eats three “steps” and not just one). The sequencer of the Fury-800 is different 
and features 256 “real” steps. In theory you can have sequences of 256 steps 
where each step stores a chord of 64 notes. 

• Editing the Poly-800 is no fun because you have to dial each parameter using 
the numeric keyboard, and there is no slider to change the parameter’s value 
(just two buttons). The Fury-800 has the option to show and edit all parameters 
at the same time.

• The Chorus effect of the Poly-800 was said to be a stereo chorus. Well, I don’t 
want to split hairs here, but in fact it was a mono chorus where the inverted 
signal was mixed to the right channel of the Poly-800’s output (quite a common 
pattern in these days). The chorus in the Fury-800 also is a mono effect, but 
here you can select if the chorus signal shall be inverted when mixed to the 
right channel or not.

Just for all the nitpickers out there: I do not claim that the Fury-800 sounds exactly 
like the Poly-800. I explicitly do state this although I doubt that all those who claim 
they can really can tell the difference. I don’t think I could (tell, I mean).

Acknowledgments

kraftraum (https://soundcloud.com/kraftraum) has designed some of the default 
patches (starting with 5 7 ), but even more I was able to win him for Beta Testing – 
thank you!!!

And at this point I would also like to say Thank you! to all the people who share their 
information about the Poly-800 via the Internet. Last not least another THANK YOU! to 
the KVR Audio community and to the KORG engineers.

No, I am not affiliated with KORG in what relation ever except that I always find 
myself entangled with their instruments. 
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General Operation

The Play Modes

The Fury-800 has three play modes: POLY, CHORD, and SEQUENCER. To select POLY 
or CHORD mode you have to press the respective button. To enter SEQUENCER mode 
(and therefore to start the sequencer), press the START/STOP button. The HOLD 
button does the obvious thing and played makes notes sound indefinitely.

Selecting a Program

The Fury-800 has 64 programs numbered in a weird fashion from 1-1 to 8-8. The first 
digit is called the bank; there are 8 banks (1 to 8) having 8 programs (1 to 8). To 
select a program from the Fury-800 front plate you have to be in POLY or CHORD 
mode (the LED display of the Fury-800 will show P or C at PARAMETER NO.).

Now you can dial in a new program number using the number pad. When you have 
pressed the first button (the bank number) the display will show something like 4 -  at 
PROGRAM NO. with a dash indicating that you have to press another number button 
for the program. Using the BANK HOLD function you can “fix” the bank: Pressing a 
number button will then immediately select the respective program of that bank. Note 
that in BANK HOLD mode the dot at PROGRAM NO. will be lit, for example like 4 . 3  
instead of 4 3 .

You can also change the program by using the DOWN and UP buttons. The Fury-800 
will then step downwards or upwards through the programs.
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Editing Parameters

Clicking the PROG/PARAM button switches into PARAMETER mode where you can edit 
the individual parameters of a program. Each parameter has a number similar to the 
program numbers which can be determined by looking at the lower part of the front 
plate (for example VCF Cutoff Resonance has the number 4 2 ). The display will show 
the number at PARAM NO. and its value at VALUE.

To change the value of a parameter you have to use the DOWN and UP buttons. If the 
value of the parameter has changed, the display will show a dot at VALUE. Note that 
this only applies as long as you do not select a different parameter or program (this is 
a funny feature of the original Poly-800 transported into the 21st century).

This is a rather tedious procedure when creating new sounds (note 
that the Apollo astronauts used a similar procedure to program 
their computer for landing on the moon!). Now, with the Fury-800 
you can directly select and edit a parameter by clicking into the 
parameter list at the front plate. This will show up a value slider 
that can be moved up and down using the mouse. There is also an 
option to show and edit the value sliders for all parameters at 
once (see section Options Menu).

Memorizing and Playing Chords

Enter POLY mode, press the HOLD button, play some notes and press CHORD. Now 
the display shows C at PARAMETER NO. and you can play the memorized chord over 
the keyboard. Of course the number of notes of the chord is limited by the current 
number of voices available (4 in DOUBLE mode, 8 in WHOLE mode, 64 in tweaked 
polyphony mode). Note that if you memorize only one note, the CHORD mode turns 
the Fury-800 into a monophonic instrument.

MIDI Learn And The Config File “fury800.ini”

Every parameter of the Fury-800 can be controlled by one MIDI controller. If you want 
to change the assignment of MIDI controller (CC; MIDI Control Change) to Fury-800 
parameter the MIDI Learn function comes in quite handy: Just click the MIDI Learn 
button on the Sound Manager panel (caption turns red) and wiggle both the MIDI 
controller and the parameter you want to assign (you can abort MIDI Learn by clicking 
the button again). If you want to unlearn the assignment, right-click the MIDI Learn 
button (the label now reads “UNLEARN”) and activate it. Now wiggle the MIDI 
controller or the parameter that you want to unlearn. To save the controller 
assignments use “Save Configuration” in the Options Menu (see next section); they 
are stored in the fury800.ini configuration file. The exact location of this file 
depends on your operating system and will be displayed when you click on “Reload” or 
“Save Configuration”.
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Options Menu

When clicking on the MENU button, a context menu opens with the following options:

Copy Program Copy current program to internal clipboard

Paste Program… Paste internal clipboard to current program (either the full 
program, only the sound, or only the sequencer data)

Init Program Initialize the current program

Load Program… Load a program file containing a patch to the Fury-800's 
current program (either the full program, only the sound, 
or only the sequencer data)

Save Program Save the Fury-800's current program to a program file

Load Bank Load a bank file containing 64 patches into the Fury-800

Save Bank Save the Fury-800's 64 patches to a bank file

Select Startup Bank Select the bank file that should always be loaded when the 
Fury-800 is started

Load Startup Bank Load the Startup bank file; can also be used to check what 
the current Startup bank is

Unselect Startup 
Bank

Unselect the current Startup bank

MIDI Thru Set globally if MIDI data sent to Fury-800 should be sent 
through to its MIDI output (stored in configuration file)

Ignore Program 
Change

Set globally if MIDI Program Change data sent to the 
Fury-800 should be ignored (stored in configuration file)

Reload Configuration Reload the Fury-800's configuration file

Save Configuration Save the Fury-800's configuration file

Show All Parameters Show or hide all parameter sliders of the Fury-800

Window Size… Change the window size of the Fury-800

Save Window Size Stores the current window size to the configuration file so 
that it will be restored on the next loading of Fury-800

Check Online for 
Update

When connected to the Internet, this function will check if 
a newer version of the Fury-800 is available at 
fullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser
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Sequencer
The Poly-800 had a polyphonic step sequencer which was a very impressive feature by 
that time, especially considering the price tag of this machine. However, one could 
store only one sequence at a time. In contrast, each program of the Fury-800 has its 
own sequence.

Recording a Sequence

The sequencer of the Fury-800 allows to record 256 steps – in step mode only, there 
is no real-time recording option. In the sequencer section, click on the RECORD light 
to activate recording (the original Poly-800 used a switch at the back of the casing 
instead). Press START/STOP to start recording (this will erase any existing sequence 
of the current program!). The display will display the program number followed by an 
“S” and the number of the current step (001) i.e. 5 O O I .

Now press one ore more keys – once you release the last key, the respective note(s) 
will be recorded for the current step, and the display shows the incremented step 
number (5 O O 2  and so forth). Here are some more commands:

• To enter a rest for the current step press the STEP button.

• To tie the notes of the current step to the next step, do not release the pressed 
keys but press the STEP button instead.

• To delete the last step press START/STOP.

• To finish recording click on the RECORD light again.

• After you have recorded the 256th step, recording will stop automatically.

Playing a Sequence

Given that a sequence was recorded for the current program, pressing the 
START/STOP button will start the sequencer (or stop it if it is already playing) – the 
SPEED slider controls the speed. Parameters 8 6  to 8 8  offer the following options:

• Synchronizing start/stop and speed with the host DAW

• Start/stop on pressing a key

• Transposing the sequence with respect to the currently played note

Note that the latter two features were not available with the Poly-800.
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Sound Creation

DCOs (Digital Controlled Oscillators)

The Fury-800 has two DCOs per voice, and each DCO offers two wave forms, 
Sawtooth and Square. Furthermore, in addition to the Octave switch, there are four 
more parameters called Harmonics (16’, 8’, 4’, and 2’) that control the wave shape. In 
fact, a DCO produces four square wave signals at 16’, 8’, 4’ and 2’. These can mixed 
by activating the Harmonic switches (sliders in case of the Fury-800).

The Wave parameter determines the weighting of the respective harmonics in the mix 
– this way it is possible to create a staircase-shaped “Sawtooth” wave. Below are 
some examples of possible wave forms.

This kind of additive synthesis is known from the KORG Delta (and my Nabla 
simulation) and gave the Poly-800 its “rough” sound character (at least that’s what 
folks say). Note again that the Harmonics and the Wave parameters of the Fury-800 
are continuous and can have any value between 0 and 1.
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DOUBLE Mode

In WHOLE mode, the Poly-800 was 8-voice polyphonic and DCO2 was deactivated. 
Switching to DOUBLE mode activated DCO2, but reduced polyphony to 4 voices. 
However, this allows for much richer and more interesting sounds, last not least 
because DCO2 features two additional parameters, namely Interval (0 to 12 notes) 
and Detune.

If DOUBLE mode is set for the current program, the display will show a dot at 
PARAMETER NO.

DEG (Digital Envelope Generator)

A very cool feature is that each DCO has its own envelope generator (DEG). Even 
more, these DEGs are of an advanced ADSR type with two extra parameters called 
Break Point and Slope.

ADBSSR envelope – the diagram right is ripped from the original Poly-800 Owner’s Manual.

Break Point is the level to which the envelope output will drop in Decay time after the 
Attack phase has completed. Slope is the time until the envelope rises or falls from 
Break Point to Sustain level.

VCF (Voltage Controlled Filter)

As stated earlier, the Poly-800 had only one filter, a 
24 dB lowpass VCF, for all voices. Technically this 
means that the Poly-800 is a paraphonic 
instrument with respect to the filter (the Fury-800 
can be set into God Mode to make it a “true” 
polyphonic machine).

The VCF has its own DEG and offers positive or 
negative envelope modulation. Triggering modes of 
the envelope are SINGLE (the DEG is only triggered if a key is pressed and no other 
key was pressed) or MULTI (the envelope is triggered for each key pressed). Note that 
in God Mode this setting has no effect. Also note that the filter  will not self-oscillate 
even if resonance is set to maximum.



Fury-800 Manual rev.2 Page 11

Noise

The white noise generator is controlled by its own LEVEL parameter and the VCF 
envelope. No surprises here.

MG (Modulation Generator)

Traditionally, the LFOs of KORG instruments were called “Modulation Generators”, and 
there is one in the Poly/Fury-800. It creates a sine wave, can be delayed and has 
parameters for DCO and VCF modulation intensity.

Chorus

Although claimed to be stereo, the chorus was a mono effect where the inverted effect 
signal has been mixed with the right output of the synthesizer. Besides a somehow 
uncomfortable listening experience (especially under headphones) this becomes 
audible when the left and right output are mixed to a mono sum – then the chorus 
signal will be canceled out completely. Thus, the Fury-800 features an additional 
switch to (de)activate this “stereo” option.

Note that the speed of the chorus effect was fixed on the Poly-800. The Fury-800 adds 
a hidden parameter (#61) to change the speed.

Modulation Wheel

For real-time modulation purposes, the Poly-800 like many of its relatives featured the 
cool KORG joystick. As with all my other KORG simulations I added some controls that 
“emulate” the joystick using the ubiquitous modulation wheel. Therefore the Fury-800 
has sliders for controlling each the MG-to-DCO and MG-to-VCF intensities controlled 
by the modulation wheel.

Velocity

The Poly-800 did not react to velocity information but the Fury-800 does. The 
intensity can be controlled by the VELOCITY slider.
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Parameters

DCO1

parameter ID number description

OCTAVE 5 I I Octave

WAVE 6 I 2 Wave form (Sawtooth or Square)

16’ 7 I 3 16’ harmonic level

8’ 8 I 4 8’ harmonic level

4’ 9 I 5 4’ harmonic level

2’ 10 I 6 2’ harmonic level

LEVEL 11 I 7 Total level

DCO Mode

parameter ID number description

MODE 12 I 8 DCO mode (WHOLE or DOUBLE)

DCO2

parameter ID number description

OCTAVE 13 2 I Octave

WAVE 14 2 2 Wave form (Sawtooth or Square)

16’ 15 2 3 16’ harmonic level

8’ 16 2 4 8’ harmonic level

4’ 17 2 5 4’ harmonic level

2’ 18 2 6 2’ harmonic level

LEVEL 19 2 7 Total level

INTERVAL 20 3 I Interval in notes

DETUNE 21 3 2 Detuning

Noise

parameter ID number description

LEVEL 22 3 3 Noise level

VCF

parameter ID number description

CUTOFF 23 4 I Cutoff frequency

RESONANCE 24 4 2 Resonance
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parameter ID number description

KBD TRACK 25 4 3 Keyboard tracking

POLARITY 26 4 4 Polarity of DEG modulation

EG INTENSITY 27 4 5 Intensity of DEG modulation

TRIGGER 28 4 6 Trigger mode (SINGLE or MULTI)

Chorus

parameter ID number description

CHORUS 29 4 8 Chorus on or off

DEG1 (for DCO1)

parameter ID number description

ATTACK 30 5 I Attack time

DECAY 31 5 2 Decay time

BREAK POINT 32 5 3 Break Point level

SLOPE 33 5 4 Slope time

SUSTAIN 34 5 5 Sustain level

RELEASE 35 5 6 Release time

DEG2 (for DCO2)

parameter ID number description

ATTACK 36 6 I Attack time

DECAY 37 6 2 Decay time

BREAK POINT 38 6 3 Break Point level

SLOPE 39 6 4 Slope time

SUSTAIN 40 6 5 Sustain level

RELEASE 41 6 6 Release time

DEG3 (for VCF and Noise)

parameter ID number description

ATTACK 42 7 I Attack time

DECAY 43 7 2 Decay time

BREAK POINT 44 7 3 Break Point level

SLOPE 45 7 4 Slope time

SUSTAIN 46 7 5 Sustain level

RELEASE 47 7 6 Release time
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MG

parameter ID number description

FREQUENCY 48 8 I MG speed

DELAY 49 8 2 Delay time

DCO 50 8 3 DCO modulation level

VCF 51 8 4 VCF modulation level

Sequencer

parameter ID number description

SEQ. CLOCK 52 8 6 Sync to host DAW

PLAY ON NOTE 53 8 7 Start/Stop on key pressed

TRANSPOSE 54 8 8 Transpose sequence on played note

Other Parameters

parameter ID description

VOLUME 0 Total volume

TUNE 1 Master tune

BEND 2 Amount of pitch bending

SEQ. SPEED 3 Sequencer speed

KEY ASSIGN 4 Keyboard mode (POLY or CHORD)

VOICES 55 Number of voices (8/4 or 64)

GOD MODE 56 God Mode on or off

“STEREO” CHORUS 57 “Stereo” chorus effect on or off

WHEEL TO DCO 58 Intensity of Mod Wheel to DCO modulation

WHEEL TO VCF 59 Intensity of Mod Wheel to VCF modulation

VELOCITY 60 Intensity of velocity

CHORUS RATE 61 Chorus speed (hidden parameter)
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Frequently Asked Questions

How do I install the Fury-800 (Windows 32 bit version)?
Just copy the files fury800.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST plug-in folder. Your DAW should automatically register 
the Fury-800 VST plug-in the next time you start it.

How do I install the Fury-800 (Windows 64 bit version)?
Just copy the file fury80064.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST plug-in folder. Your DAW should automatically register 
the Fury-800 VST plug-in the next time you start it.

Note: You may have to remove any existing (32 bit) fury800.dll from your VST 
plug-in folder or else your DAW may screw the versions up...

How do I install the Fury-800 (Mac VST/AU 64 bit)?
Locate the downloaded PKG package file fury800_1_0_0_mac.pkg in Finder (!) and do 
a right- or control-click on it. In the context menu, click on “Open”. You will be asked 
if you really want to install the package because it comes from an “unidentified 
developer” (me ). Click “OK” and follow the installation instructions.

What is the plug-in ID of the Fury-800?
The ID is f 8 0 0 .

How can I decrease the Fury-800's CPU load?
Whenever it does not degrade the sound you need, switch off God Mode and reduce 
the number of voices to 8/4 (instead of 64).

How do I know if a new version of the Fury-800 is available?
When connected to the Internet, open the File menu (see section Options Menu) by 
clicking the disk icon and select the entry “Check Online for Updates”. If a new version 
of the Fury-800 is available on fullbucket.de the respective information will be shown 
in a message box.

How do I resize the Fury-800 window?
Just grab the yellow triangle at the bottom right of the Fury-800 window and drag it. 
You can save the current window size using the menu entry  “Save Window Size” in 
the Options Menu.

Can I load/paste only the sound or sequencer data of a program?
Yes you can! Please see section Options Menu.
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